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Introduction

Audience - People who work with Intelligent Advisor policy models. It is assumed 
the reader has already had training and is familiar with using v12.x Policy Modeling.

Purpose - Provide ideas and suggestions for polishing your policy models, and 
direct you to relevant topics in the Intelligent Advisor documentation.

Tip - Latest version of the Using Policy Modeling guide can be found online and via 
the question mark button in Policy Modeling.

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/index.html


Example Projects
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Policy Modeling includes Example Policy Models that 
demonstrate features discussed in this deck

Filter examples by Industry
and Feature

Example projects available 
from the Project tab

Example projects available 
from the Project tab

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Projects/Example_policy_models.htm


Tips for Polishing Your Policy Model

Screen Configuration
• Labels on Interview Screens

• Interview Stages

• Navigation Strip

• Containers

• Entity Collect Screen

• Images on Interview Screens

Enhancing Interviews
• Look and Feel of Interviews

• Document Generation using 
Analytics Publisher

• User’s Location

• Attribute Value Formats

• Standard Message Strings

User Input
• Default Values

• Value Lists

• Hint Text

• Validation – Event rules

• Validation – Data tab

• Input Masks

Substitution & Sentence Generation
• Name Substitution

• Gender Pronoun Substitution

• Second Person Sentence Generation

• Names in Labels

Language Support
• Custom Verbs

• Translation Layer

• Rules in Other Languages

Improving the Explanation
• Intermediate Attributes

• Rule Tags

• Trimmed Explanations – Attributes

• Trimmed Explanations –
Relationships
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Screen Configuration



Labels on Interview Screens
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• Add text to screens

• Add a label control

• Specify the type of 
label

• Hide and show screen 
controls

• Show attribute values on 
screens

• Show attribute values 
in other screen text

• Use embedded HTML in 
an interview

Documentation

• Labels can:

- be added to provide context and additional info

- be used as additional headings and subheadings

- include raw text, as well as HTML

- have conditional visibility

- contain substitution

Example labels

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Add_text_to_screens.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Add_a_label_control.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Specify_type_of_label.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Specify_type_of_label.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Hide_and_show_screen_controls.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Hide_and_show_screen_controls.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Show_attribute_values_on_screens.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Show_attribute_values_on_screens.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Show_attribute_values_in_other_screen_text.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Show_attribute_values_in_other_screen_text.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Design_interviews/Use_HTML_in_interview_text.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Design_interviews/Use_HTML_in_interview_text.htm


Interview Stages
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• Organize an interview 
into stages

Documentation

• Group related interview screens together in a folder

• Folder becomes a stage in the interview

Policy Modeling
(design time)

Interview stage

Interview stage

Interview screen

Interview screen

Interview
(run time)

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Design_interviews/Organize_interview_into_stages.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Design_interviews/Organize_interview_into_stages.htm


Navigation Strip
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• Configure the navigation 
strip

Documentation

• Navigation strip may be 
displayed at the top or 
left of the page

• Many configuration 
options available, e.g. 
text color, text size, 
background color

Left menu

Train stops

Ribbon Thermometer

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Design_interviews/Configure_navigation_strip.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Design_interviews/Configure_navigation_strip.htm


Containers
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• Change control layout 
for a screen

• Example project:
myBenefits

Documentation

• Containers may be used to lay out screen controls side-by-side

• Containers allow for responsive design in interviews, e.g. two columns which 
collapse to a single column in a small browser

• Labels and images may also be put in containers

Screen controls laid 
out in two columns. 
Efficient use of space 

on a larger screen
Screen controls 

automatically collapse to 
one column in a narrow 
browser window. More 

readable on a small screen.

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Change_control_layout_for_a_screen.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Change_control_layout_for_a_screen.htm
https://opalive-opa.custhelp.com/opalive_opa/web-determinations/startsession/myBenefits


Entity Collect Screen
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• Collect entity instances

• Example project:
myBenefits

Documentation

• Entity collection layout can be ‘portrait’ or ‘tabular’ style

• Tabular will usually make more efficient use of screen space

• Containers can also be used inside the entity collect space to control layout

Entity collect screen 
with tabular layout

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Collect_entity_instances.htm
https://opalive-opa.custhelp.com/opalive_opa/web-determinations/startsession/myBenefits


Images on Interview Screens
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• Add images to screens

• Refer to images using 
HTML tags

• Place other controls 
within a container

• Example project:
Energy Saver

Documentation

• Add images to interview screens as useful visual aids

• Many configuration options available for images, e.g. horizontal alignment (left, 
center, right), image size, conditional visibility, clickable link

• Images may be placed in 
containers for further 
layout control

• Use text substitution to 
insert different images 
depending on the value of a 
substituted attribute

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Add_images_to_screens.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Design_interviews/Refer_to_images_using_HTML.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Design_interviews/Refer_to_images_using_HTML.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Place_other_controls_within_container.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Place_other_controls_within_container.htm
https://opalive-opa.custhelp.com/opalive_opa/web-determinations/startsession/EnergySaver


Enhancing Interviews



Look and Feel of Interviews
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• Many aspects of the interview look and feel can be set in the Styles section 
of the Interview tab, e.g. color scheme, banner graphic, heading styles, 
button location, footer and header
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Styles section in 
Policy Modeling

• Configure the 
appearance of the 
interview

• Change the appearance 
of interview items

Documentation

Interview and 
the Debugger

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Design_interviews/Configure_appearance_of_interview.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Design_interviews/Configure_appearance_of_interview.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Design_interviews/Configure_appearance_of_interview.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Design_interviews/Change_appearance_of_interview_items.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Design_interviews/Change_appearance_of_interview_items.htm


Document Generation using Analytics Publisher
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• Generate documents from interviews, e.g. letters, forms, etc. Policy 
Modeling supports creation of RTF, PDF, HTML, XML & Excel forms

• Forms may include text, images, charts, explanations, signatures

• Note: Requires installation of Analytics Publisher Desktop. This is a 
separate product. It is not part of Oracle Policy Modeling.
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• Overview of forms

• Create or modify a form

• Overview of designing a 
form

• Design an RTF template
or a PDF template for a 
form 

• Add forms to screens

• Insert a signature into a 
form

• Analytics Publisher code 
for Policy Modeling

• Download Analytics 
Publisher

• Troubleshooting guide 
for forms

• Example project:
Healthy Eating

Documentation

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Forms/Forms.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Forms/Create_or_modify_form.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Forms/Overview_of_designing_a_form.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Forms/Overview_of_designing_a_form.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Forms/Design_RTF_template_form.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Forms/Design_PDF_form_template.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Add_forms_to_screens.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Forms/Insert_signature_into_RTF_form_template.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Forms/Insert_signature_into_RTF_form_template.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Forms/Analytics_Publisher_code_for_OPM.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Forms/Analytics_Publisher_code_for_OPM.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Forms/Download_Analytics_Publisher.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Forms/Download_Analytics_Publisher.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Forms/Troubleshooting_guide_for_forms.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Forms/Troubleshooting_guide_for_forms.htm
https://opalive-opa.custhelp.com/opalive_opa/web-determinations/startsession/HealthyEating


User’s Location
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• User’s location (latitude and longitude) may be captured during the 
interview using standard browser location support

• Latitude and longitude may be used in rules
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Generate map URL to 
add to interview screen

Compare distance 
between locations

• Capture the user’s 
location

• Example projects:
My Store App, Emergency 
Response

Documentation

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Capture_user_location.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Capture_user_location.htm
https://opalive-opa.custhelp.com/opalive_opa/web-determinations/startsession/MyStoreApp
https://opalive-opa.custhelp.com/opalive_opa/web-determinations/startsession/EmergencyResponse
https://opalive-opa.custhelp.com/opalive_opa/web-determinations/startsession/EmergencyResponse


Attribute Value Formats
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• Default attribute value formats are based on the project region 
(for non-Boolean attributes) and the project language (for 
Boolean attributes)

• E.g. If project language = ‘English (American)’ and 
region = ‘United States (English)’ then:

- Default currency symbol: $

- Default date out format: MM/dd/yyyy

- Default Boolean values: Yes/No

• Default attribute value formats can be modified in: 
Project > Language > Formatting

• Generally will not need to edit default formats, 
but configuration options are there if needed
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• Change the formatting of 
attribute values in an 
interview

Documentation

Format settings in 
Policy Modeling

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Design_interviews/Change_formatting_of_interview_attribute_values.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Design_interviews/Change_formatting_of_interview_attribute_values.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Design_interviews/Change_formatting_of_interview_attribute_values.htm


Standard Message Strings
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• Note: Button labels (e.g. Next, Back, Submit, Add 
New Instance, Remove) can also be modified on a 
per-button basis

• To change all occurrences of a message string →
modify the default string, e.g. to use ‘Continue’ 
instead of ‘Next’ as the standard label on a Next 
button

• To change one occurrence of a button label →
make the change on the individual screen
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Strings settings in 
Policy Modeling

• Change the text of 
buttons, messages and 
other built-in interview 
items

Documentation

• Default message strings and labels (e.g. standard error text, alt-text, button labels, etc.) 
can be modified in Interview > Styles > Strings

• Generally will not need to edit default message strings, but configuration options are 
there if needed

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Design_interviews/Change_text_of_interview_items.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Design_interviews/Change_text_of_interview_items.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Design_interviews/Change_text_of_interview_items.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Design_interviews/Change_text_of_interview_items.htm


User Input



Default Values
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• Can set default values for inputs on interview screens

- Defaults can be specific values, or can be dynamically determined based 
on previously collected data, or inferred from rules

• Reduces the typing/clicking required to complete an interview
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All currency values have been 
defaulted to $0. User only needs to 
edit the fields for which they have 

income. Reduces manual data entry.

• Specify a default for an 
input

Documentation

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Specify_default_for_input.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Specify_default_for_input.htm


Value Lists
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• A value list is a way of managing lists of values for attributes

• A single value list can be attached to multiple attributes, e.g. the person’s home 
address, the person’s work address

• Value lists can be created manually, imported from another Policy Modeling 
project, or loaded in from a B2C Service connection or web service connection.

• Value lists can be displayed as lists, radio buttons, text buttons, images, sliders
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• Overview of value lists

• Set up a value list in a 
project

• Associate a value list with 
an attribute collected on 
a screen

• Hide and show individual 
items in a value list

• Button types

• List types

• Example projects: 
Loan Advisor, myBenefits

Documentation

Value list displayed as 
image buttons

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Value_lists/Value_lists.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Value_lists/Set_up_a_value_list_in_a_project.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Value_lists/Set_up_a_value_list_in_a_project.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Value_lists/Associate_a_value_list_with_an_attribute.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Value_lists/Associate_a_value_list_with_an_attribute.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Value_lists/Associate_a_value_list_with_an_attribute.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Value_lists/Hide_and_show_individual_items_in_value_list.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Value_lists/Hide_and_show_individual_items_in_value_list.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Button_types.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/List_types.htm
https://opalive-opa.custhelp.com/opalive_opa/web-determinations/startsession/LoanAdvisor
https://opalive-opa.custhelp.com/opalive_opa/web-determinations/startsession/myBenefits


Hint Text
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• Can supply hint text for inputs on interview screens

- Hint text appears until the user clicks into the input field

• Tip: Always add hint text when the format of the input is important, for example:

- Date fields

- Any sort of ID number like SSN, TFN, NINO, PHN
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• Specify hint text

Documentation

Hint text showing the 
required date format

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Specify_hint_text.htm


Validation – Event Rules
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• Error event and Warning event rules may be used where there is conditional logic 
associated with the validation, e.g.

- Display the message “Expected due date must be in the future” if the user enters an 
expected child due date in the past
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• Validate user input

• Write rules to validate 
user input

Documentation

• Error event: Error message is displayed and the 
user is prevented from continuing until the 
situation that triggered the event is no longer 
present.

• Warning event: Warning message is displayed, 
but the user is able to click past and continue the 
interview.

Error from an 
error event rule

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Validate_user_input.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Work_with_rules/Write_rules_validate_user_input/Write_rules_to_validate_user_input.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Work_with_rules/Write_rules_validate_user_input/Write_rules_to_validate_user_input.htm


Validation – Data Tab
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• Use min/max values if there is no 
conditional logic for triggering the error, 
e.g.

- ‘the person’s age’ field could have a 
minimum allowable value of 0 and a 
maximum of 120

• Use regular expressions to validate the 
format of an input such as an email 
address, an SSN, a TFN, a NINO or a 
PHN, e.g.

- ^[0-9]{3}-?[0-9]{2}-?[0-9]{4}$ is a 
basic SSN validation – allows for 
NNN-NN-NNNN and NNNNNNNNN
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• Validate user input

• Specify validations on 
individual inputs

Other info

• http://en.wikipedia.org/
wiki/Regular_expression

Documentation

Input validation on 
an attribute

• Validation with regular expressions and min/max can be done on the attribute in 
the Data tab

- Error text may be configured on a per attribute basis

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Validate_user_input.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Specify_validations_individual_inputs.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Specify_validations_individual_inputs.htm
http://en.wikipedia.org/wiki/Regular_expression
http://en.wikipedia.org/wiki/Regular_expression


Input Masks
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• Masked input text boxes may be used to auto-format data entered into 
text fields, e.g. phone numbers, social security numbers, product codes, etc.

• Input masks can effectively act as a type of validation since the input field 
won’t allow the user to type offending characters, e.g. an input mask 
containing only numbers will not allow letters to be entered.

• Masked input text boxes can only be used with text attributes.

Copyright © 2025, Oracle and/or its affiliates |  Public

• Masked input text boxes

Documentation

Uses the input mask: 
(999) 999 9999

Uses the input mask: 
A*999AA*

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Masked_input_text_boxes.htm


Substitution and Sentence 
Generation



Name Substitution
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• Personalizes the interview for a more 
user-friendly experience

• Collect the person’s name early in the 
interview, then substitute the name in 
later questions, e.g. “Does the person 
have insurance?” becomes “Does John 
have insurance?”

• Personalize attribute text

• Enable substitution 
in Policy Modeling

• Understand text 
substitution 
principles

• Combine multiple text 
strings into a single text 
attribute

Documentation

Name collected

• Particularly important when using entities, e.g. 
“Is the child a full-time student?” becomes “Is 
Emma a full-time student?”, “Is Joshua a full-
time student?”, etc.

• Substituted name automatically appears in 
attribute text on interview screens and in 
explanations

• If first and last name collected separately, use 
concatenation to combine if full name needed 
for substitution in attributes

Name 
substituted

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Attributes/Personalize_attribute_text.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Attributes/Enable_substitution_in_OPM.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Attributes/Enable_substitution_in_OPM.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Attributes/Understand_text_substitution_principles.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Attributes/Understand_text_substitution_principles.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Attributes/Understand_text_substitution_principles.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Work_with_rules/Write_rules_text_strings/Combine_mult_text_strings_into_single_text_variable.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Work_with_rules/Write_rules_text_strings/Combine_mult_text_strings_into_single_text_variable.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Work_with_rules/Write_rules_text_strings/Combine_mult_text_strings_into_single_text_variable.htm


Gender Pronoun Substitution
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• May be used in combination, or in isolation, with name substitution to 
personalize the interview for a more user-friendly experience, and to 
provide more natural language text

• Gender pronoun substitution requires collecting gender

• Personalize attribute text

• Enable substitution 
in Policy Modeling

• Substitute a 
pronoun for a text 
attribute

• Understand text 
substitution 
principles

• Collect the gender of a 
person

Documentation

In combination with name substitution, 
“Has the applicant submitted the 

applicant’s tax return?” becomes “Has 
Christopher submitted his tax return?”

Original rule generically 
refers to “the applicant”

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Attributes/Personalize_attribute_text.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Attributes/Enable_substitution_in_OPM.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Attributes/Enable_substitution_in_OPM.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Attributes/Substitute_a_pronoun_for_text_attribute.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Attributes/Substitute_a_pronoun_for_text_attribute.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Attributes/Substitute_a_pronoun_for_text_attribute.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Attributes/Understand_text_substitution_principles.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Attributes/Understand_text_substitution_principles.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Attributes/Understand_text_substitution_principles.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Collect_gender_of_person.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Collect_gender_of_person.htm


Second Person Sentence Generation
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• Similar concept to name substitution, but sentences/questions generated in 
second person rather than third person

• Requires name substitution to be set up first

• Works with gender pronoun substitution if it has been set up

• Display interview text in 
second person form

• Also see the topics for 
Name Substitution

Documentation

Example: Instead of “Has the 
applicant submitted the applicant’s 
tax return?” it displays “Have you 

submitted your tax return?”

Example: Instead of “Does the 
applicant have health insurance?” it 

displays “Do you have health 
insurance?”

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Display_interview_text_in_second_person_form.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Display_interview_text_in_second_person_form.htm


Names in Labels
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• Variable values (e.g. person’s name, age, etc.) can be substituted into labels on 
interview screens

• Requires name substitution to be set up first

• Tip: For substitution in labels, make sure the substitution values will always be 
known in advance of the screen being displayed, otherwise “unknown” will 
appear in place of the substitution value

• Personalize attribute text

• Enable substitution 
in Policy Modeling

• Understand text 
substitution 
principles

• Show attribute values on 
screens

• Show attribute 
values in other 
screen text

Documentation

Example: The person’s name and age 
were collected on a previous screen, 

and those values have been substituted 
into label text on the School screen

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Attributes/Personalize_attribute_text.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Attributes/Enable_substitution_in_OPM.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Attributes/Enable_substitution_in_OPM.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Attributes/Understand_text_substitution_principles.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Attributes/Understand_text_substitution_principles.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Attributes/Understand_text_substitution_principles.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Show_attribute_values_on_screens.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Show_attribute_values_on_screens.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Show_attribute_values_in_other_screen_text.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Show_attribute_values_in_other_screen_text.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Screens/Show_attribute_values_in_other_screen_text.htm


Language Support



Custom Verbs
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• Default verb list for the policy model is 
based on the Rule Language selected 
when creating the project

• Occasionally you may need a new verb

• If a Boolean won’t parse properly, it’s a 
sign the statement’s operative verb may 
not be in the verb list

• Options are to re-word the attribute to use 
a different operative verb, or add the new 
verb to the list for the project

• Configure the list of 
recognized verbs

Documentation

This statement won’t parse as 
intended as the operative verb 

(love) is not in the default verb list

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Attributes/Configure_list_of_recognized_verbs.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Attributes/Configure_list_of_recognized_verbs.htm


Translation Layer
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• Create one or more translation layers, e.g. policy model in English, 
interview in choice of English, Spanish or French

• Even a partial translation layer is sufficient to demo the concept. Google 
Translate can be used for basic demos. Use a (human) translation expert 
for real implementations

• Generated forms can also be created in different languages

• Translate policy models 
into other languages

• Create a form in a 
different language

• Example project: 
Travel Compensation

Documentation

English policy model
… with Spanish 
translation layer

… and Chinese 
translation layer

http://translate.google.com/
http://translate.google.com/
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Other_language_support/Translate_policy_model_other_language.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Other_language_support/Translate_policy_model_other_language.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Forms/Create_a_form_in_a_different_language.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Forms/Create_a_form_in_a_different_language.htm
https://opalive-opa.custhelp.com/opalive_opa/web-determinations/startsession/Travel+Compensation


Rules in Other Languages
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• Many languages available out-of-the-box for rule authoring

- For additional languages, create a custom language parser

• Function Reference is available in out-of-the-box languages

• When creating a new project, select the desired Rule Language and Rule Region

• Rule Language:

- Language in which rule documents are written

• Rule Region:

- Affects currency, numeric and date formatting of data entered and displayed

- Affects parsing of currency and number constants in rule documents

• Write rules in other 
languages

• Change the user 
interface language for 
Policy Modeling

• Change the language of 
the Intelligent Advisor 
Hub

• Custom language 
support

• Function references in 
different languages

Documentation

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Other_language_support/Write_rules_in_other_languages.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Other_language_support/Write_rules_in_other_languages.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Other_language_support/Change_UI_language_Policy_Modeling.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Other_language_support/Change_UI_language_Policy_Modeling.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Other_language_support/Change_UI_language_Policy_Modeling.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Other_language_support/Change_language_Intelligent_Advisor_Hub.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Other_language_support/Change_language_Intelligent_Advisor_Hub.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Other_language_support/Change_language_Intelligent_Advisor_Hub.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Other_language_support/Custom_language_support.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Other_language_support/Custom_language_support.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Work_with_rules/Function_references/Function_references.htm


Improving the Explanation



Intermediate Attributes
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• Intermediate attributes can be added to make the explanation more meaningful

- These two examples have identical core logic, but Example 2 
has a more meaningful explanation due to the inclusion of intermediate attributes

* Explanations previously called Decision Reports

Copyright © 2025, Oracle and/or its affiliates |  Public

• Design an explanation

• Add more information to 
an explanation

• Add intermediate 
rules or text 
substitution

• Replace grouping 
operators with new 
attributes

Documentation

Example 1 Example 2

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Explanations/Design_an_explanation.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Explanations/Add_more_information_to_an_explanation.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Explanations/Add_more_information_to_an_explanation.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Explanations/Add_intermediate_rules_or_text_substitution.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Explanations/Add_intermediate_rules_or_text_substitution.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Explanations/Add_intermediate_rules_or_text_substitution.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Work_with_rules/Write_rules_in_Word/Replace_grouping_operators_with_new_attributes.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Work_with_rules/Write_rules_in_Word/Replace_grouping_operators_with_new_attributes.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Work_with_rules/Write_rules_in_Word/Replace_grouping_operators_with_new_attributes.htm


Rule Tags

36

• Structural elements in legislation (e.g. section, paragraph, article) and policy (e.g. 
chapter, guideline) can be captured in rules and displayed in explanations in interviews

* Rule Tags previously called Structural Elements
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• Add reference tags to a 
Word rule

• Add reference tags to an 
Excel rule

• Show reference tags in 
an explanation

• Example project: 
Travel Compensation

Documentation

Rule tags in an 
explanation in an 

interview

Rule with rule tags

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Work_with_rules/Write_rules_in_Word/Add_reference_tags_to_Word_rule.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Work_with_rules/Write_rules_in_Word/Add_reference_tags_to_Word_rule.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Work_with_rules/Write_rules_in_Excel/Add_reference_tags_to_Excel_rule.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Work_with_rules/Write_rules_in_Excel/Add_reference_tags_to_Excel_rule.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Explanations/Show_reference_tags_in_explanation.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Explanations/Show_reference_tags_in_explanation.htm
https://opalive-opa.custhelp.com/opalive_opa/web-determinations/startsession/Travel+Compensation


Trimmed Explanations – Attributes
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• Explanations automatically generated based on the logic, language and 
structure of the rules can be extremely verbose

• Can trim explanations using Silent and Invisible settings on the attribute 
in the Data tab

- Silent: Hide all logic nested below a particular attribute

- Invisible: Hide the attribute only
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• Hide information in an 
explanation

• Hide attributes in an 
explanation

Documentation

Options for Booleans Options for non-Booleans

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Explanations/Hide_information_in_an_explanation.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Explanations/Hide_information_in_an_explanation.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Explanations/Hide_attributes_in_explanation.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Explanations/Hide_attributes_in_explanation.htm


Trimmed Explanations – Relationships
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• Silent and Invisible can be applied to relationships

- See examples below with a containment relationship (the household 
members) and an inferred relationship (the children)
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• Hide information in an 
explanation

• Hide a relationship 
in the explanation

Documentation

No trimming

Invisible set 
on the 
containment 
relationship

Invisible on 
containment 
relationship

Silent on 
inferred 
relationship

Invisible set on 
both relationships

Invisible on 
containment 
relationship

Silent and 
Invisible on 
inferred 
relationship

https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Explanations/Hide_information_in_an_explanation.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Explanations/Hide_information_in_an_explanation.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Explanations/Hide_relationship_in_explanation.htm
https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/Content/Guides/Use_Intelligent_Advisor/Use_Policy_Modeling/Explanations/Hide_relationship_in_explanation.htm


Documentation and 
Further Information

Using Policy Modeling guide

Intelligent Advisor General Discussion Forum

Intelligent Advisor blog
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https://docs.oracle.com/en/cloud/saas/intelligent-advisor/using-policy-modeling/index.html
https://forums.oracle.com/ords/apexds/domain/dev-community/category/intelligent_advisor?tags=intelligent-advisor-general-discussion
https://blogs.oracle.com/ia/
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